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Setup Handbook

Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the Safety Information 

in this manual before using the machine.

Using User Guide

Troubleshooting
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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your safety and 
benefit, read this manual carefully before using the machine. Keep this manual in a handy place for quick reference.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its completeness or accu-
racy. If you have any questions concerning the legality of copying or printing certain items, consult with your legal advisor.

Power Source

220 240V, 50/60Hz, 0.5A or more

Voltage must not fluctuate more than 10%.

Please be sure to connect the power cable to a power source as above.

Confirm that the wall outlet is near the machine and freely accessible, so that in event of an emergency, it can be un-
plugged easily.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, 
indirect, special, incidental, or consequential damages as a result of handling or operating the machine.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

For good print quality, the supplier recommends that you use genuine print cartridges from the supplier.

The Supplier shall not be responsible for any damage or expense that might result from the use of parts other than 
genuine Supplier parts with your Supplier office products.

Trademarks

Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United 
States and/or other countries.

Pentium is a registered trademark of Intel Corporation.

Netscape is a registered trademark of Netscape Communication Corporation in the U.S. and/or other countries.

Macromedia and Flash are either registered trademarks or trademarks of Macromedia, Inc. in the U.S. and/or other 
countries.

Microsoft, Windows, Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the 
U.S. and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their respective com-
panies. We disclaim any and all rights to those marks.

� The product name of Windows®98 is Microsoft® Windows® 98.

� The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

� The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

� The product names of Windows® XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional

� The product names of Windows ServerTM 2003 are as follows:

Microsoft® Windows ServerTM 2003 Standard Edition

Microsoft® Windows ServerTM 2003 Enterprise Edition

Microsoft® Windows ServerTM 2003 Web Edition

� The product names of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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Safety Information

When using this machine, the following safety precautions should always be followed.

Safety During Operation

In this manual, the following important symbols are used: 

Indicates a potentially hazardous situation which, if instructions are not followed, could result in 

death or serious injury.

Indicates a potentially hazardous situation which, if instructions are not followed, may result in

minor or moderate injury or damage to property.
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Warning

The supplied power cord is for use with this equipment only. Do not use 

with other appliances. Doing so may result in fire, electric shock, or 

injury.

Only connect the machine to the power source described on the inside 

front cover of this manual.

Avoid multi wiring.

Do not damage, break or make any modifications to the power cord. Do 

not place heavy objects on it. Do not pull it hard nor bend it more than 

necessary. These actions could cause an electric shock or fire.

Do not plug or unplug the power cord with your hands wet. Otherwise, 

an electric shock might occur.

Connect the power cord directly into a wall outlet and never use an 

extension cord.

To avoid hazardous electric shock, do not remove any covers or screws 

other than those specified in this manual. When the machine needs to be 

checked, adjusted, or repaired, contact your service representative.

Do not take apart or attempt any modifications to this machine. There is 

a risk of fire, electric shock, explosion or loss of sight.

If by any chance this machine falls over or a breakage occurs (e.g. the 

cover), turn off the main switch, unplug the power cable and contact 

your service representative. If you continue to use the machine in this 

state it could result in fire or electric shock.

If metal, liquid or foreign matter falls into the machine, turn off the oper-

ation and main power switches, and unplug the main power cord. Con-

tact your service representative. Do not keep using the machine with a 

fault or defect.

Do not put any metal objects or containers holding water (e.g. vases, 

flowerpots, glasses) on the machine. If the contents fall inside the 

machine, a fire or electric shock could occur.

Keep the machine away from flammable liquids, gases, and aerosols. A 

fire or an electric shock might occur.

Disposal can take place at our authorized dealer.
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Keep the machine away from humidity and dust. Otherwise a fire or an 

electric shock might occur.

If you use the machine in a confined space, confirm that there is a contin-

uous flow of air.

Make sure the wall outlet is near the machine and freely accessible so 

that in event of an emergency it can be unplugged easily.
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Caution

Keep the machine away from humidity and dust. Otherwise a fire or an 

electric shock might occur.

Do not place the machine on an unstable or tilted surface. If it topples 

over, an injury might occur.

If you use the machine in a confined space, make sure there is a continu-

ous air turnover.

Unplug the power cord from the wall outlet before you move the 

machine. While moving the machine, you should take care that the 

power cord will not be damaged under the machine.

When the machine will not be used for a long time, unplug the power 

code.

When you disconnect the power plug from the wall outlet, always pull 

the plug (not the cable).

Our products are engineered to meet high standards of quality and func-

tionality, and we recommend that you use only the expendable supplies 

available at an autohrized dealer.

Deliver to waste product collection areas. Do not dispose of via domestic 

refuse collection.

The machine weighs approximately 14.5 kg (32.0 lb.).

When moving the machine, hold the machine by the bottom below the 

two indentations. Lift the machine slowly in order to avoid straining your 

body. Lifting the machine without sufficient strength or assistance or han-

dling it roughly and dropping it could cause an injury.

Keep the ink collector unit out of reach of children.

When you replace the ink collector unit, be careful not to get any ink on 

your clothes as it may not wash off easily.
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Rating voltage of the connector for option: Max. DC 37 V.

When you use this machine for a long time in a confined space without good ventilation, you 

may detect an odd smell. To keep the workplace comfortable, we recommend that you keep it 

well ventilated.

Do not eat or swallow ink.

If ink is ingested, induce vomiting by drinking a strong saline solution. 

Consult a doctor immediately.

If your skin comes into contact with ink, wash the affected area thor-

oughly with soap and water.

If ink comes into contact with your eyes, rinse immediately in running 

water. For other symptoms, consult a doctor.

Avoid getting ink on your clothes or skin when removing a paper jam or 

replacing ink. If your skin comes into contact with ink, wash the affected 

area thoroughly with soap and water.

If ink gets on your clothing, wash with cold water. Hot water will set the 

ink into the fabric and may make removing the stain impossible.

Keep the ink or ink container out of reach of children.

Be careful not to get ink on your clothes when replacing an ink con-

tainer. Ink stains on clothes are hard to remove.
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ENERGY STAR Program

As an ENERGY STAR Partner, we have determined that this machine model meets the ENERGY 

STAR Guidelines for energy efficiency.

Positions of WARNING and CAUTION labels

This machine has labels for WARNING and CAUTION at the positions shown below. For 

safety, please follow the instructions and handle  the machine as indicated.

1 The ink collector unit for storing ink is installed in the printer. Be careful not to spill the ink.

AKR181S

1

1
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User Information on Electrical & Electronic Equipment

1) Users in the EU, Switzerland and Norway

Our Products contain high quality components and are designed to facilitate recycling.

Our products or product packaging are marked with the symbol below. The symbol indicates 

that the product must not be treated as municipal waste. It must be disposed of separately via 

the appropriate return and collection systems available. By following these instructions you 

ensure that this product is treated correctly and help to reduce potential impacts on the environ-

ment and human health, which could otherwise result from inappropriate handling. Recycling 

of products helps to conserve natural resources and protect the environment.

For more detailed information on collection and recycling systems for this product, please con-

tact the shop where you purchased it, your local dealer or sales/service representatives.

2) All Other Users

If you wish to discard this product, please contact your local authorities, the shop where you 

bought this product, your local dealer or sales/service representatives.
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User's Notes

High temperatures inside the printer can cause a breakdown. Do not lean anything against the 

vent or block it in any way.

Warm air from the vent is normal and not a cause for concern.

Do not leave the top cover open. Doing so could cause an injury.

During printing, do not move the printer or open its covers.

During printing, do not pull out a paper tray. Printing will stop and the paper will jam.

Do not touch the feed belt.

Take care not to let paper clips and other foreign objects fall inside the printer.

During printing, do not turn off the power or unplug the power cord from the wall outlet.

During printing, do not subject the printer to external shock such as that caused by tapping paper 

on it.

When not using the printer, turn off the power.

Do not place more than 5 kg (11.1 lb.) on the printer. (The outer surface of the printer can tolerate 

up to 20 kg (44.1 lb.).)

This printer has a nominal operational life of 5 years if used normally for 8 hours a day to pro-

duce up to 2,500 A4 prints a month. Exceeding these limits may reduce the operational life. The 

operational life also depends on the environment in which the printer is used.

”Total Counter” displays the number of pages printed. Use "Total Counter" to estimate the 

number of pages that can be printed within the printer's remaining operational life. The printer's 

operational life is calculated based on the number of pages that it can print on plain paper in 

[Speed priority] mode.

This printer is designed to have an operational life of 5 years or be good for 150,000 pages.

Depending on your printing document, the ink collector unit may fill up sooner than normal.

An "Ink Collector almost full" message appears shortly before the ink collector unit is full. Contact 

your service representative as soon as possible for a replacement ink collector unit (charge 

incurred).

The printing yields of print cartridges are as follows: (The yields of the print cartridges packaged 

with the printer are lower than the yields described below.)

Black: approximately 1500 A4/Letter sheets (5% chart)

Cyan: approximately 1000 A4/Letter sheets (5% chart)

Magenta: approximately 1000 A4/Letter sheets (5% chart)

Yellow: approximately 1000 A4/Letter sheets (5% chart)

Printing yields vary depending on page content, paper type, paper size, and environmental con-

ditions. Also, cartridges may need to be changed before the yields above have been reached 

due to deterioration over time. To maintain print quality, cartridges should be opened before their 

expiration date and used within six months of being opened.
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Ink can remain inside used print cartridges.

Colour ink may be used even if you print all black text or if you specify black and white printing. 

It may also be used for print head cleaning and refreshing, which are done to maintain printer 

performance.

Print cartridges and supplies comply with the manufacturer's safety specifications. To ensure 

safety and reliability, use genuine print cartridges and supplies.

Black and white printing also consumes colour ink.

Printing stops if one of the print cartridges becomes empty. If a cartridge containing a colour ink 

such as cyan, yellow, or magenta becomes empty, you cannot print, even in black/white.

If you print a large number of pages in a day, for instance, hundreds of pages, the nozzles of the 

print heads may be clogged the next day. If this happens, clean the print heads.

This printer performs regular automatic maintenance, after and during printing, to ensure consist-

ent print quality. Maintenance is also performed when printing begins after a period of disuse.
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Manuals for This Printer

This printer is provided with two manuals.

Quick Installation Guide

This manual describes procedures from unpacking the printer to loading paper.

Setup Handbook (this manual)

Topics such as printer installation, connecting to a computer, and basic print operations are 

explained.

User Guide (CD ROM)

This is included on the provided "Driver, Manual & Utility" CD ROM. Topics such as advanced 

features, troubleshooting when printing does not start or is not performed as expected, dealing 

with paper jams, and information about paper are explained. We recommend that you install this 

manual on computers for your convenience.

Depending on the operating system and version used, actual procedures may differ from the pro-

cedures explained in these manuals.
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How to Read This Manual

Symbols

The following set of symbols is used in this manual.

This symbol indicates a potentially hazardous situation that might result in death or serious injury 

when you misuse the machine without following the instructions under this symbol. Be sure to read 

the instructions, all of which are described in the Safety Information section.

This symbol indicates a potentially hazardous situation that might result in minor or moderate injury 

or property damage that does not involve personal injury when you misuse the machine without fol-

lowing the instructions under this symbol. Be sure to read the instructions, all of which are described 

in the Safety Information section.

* The statements above are notes for your safety.

If this instruction is not followed, paper might be misfed, originals might be damaged, or data might 

be lost. Be sure to read this.

This symbol indicates precautions for operation, or actions to take after abnormal operation.

This symbol indicates a reference.

Keys

     [   ]
Indicates the name of keys and buttons.
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1. Using User Guide

This section explains how to install and use the User Guide.

Installing User Guide

Follow the procedure below to install User Guide only.

If you installed the software when performing [Quick Install for USB] or [Quick Install for Network], 

there is no need to install it again here.

The following explanation uses Windows 2000 as an example. Procedures under other operating 

systems may differ.

Screens vary according to the operating environment.

1 Start Windows, and insert the provided "Driver, Manual & Utility" CD ROM into the CD ROM 

drive.

Quit all other applications currently running.

After inserting the CD ROM, the [Driver, Manual & Utility] dialog box appears. If it does not, dou-

ble click the CD ROM drive icon under [My Computer] or [Explorer], and then double click [SET-

UP.EXE].

2 Select a language for the interface, and then click [OK].

The following languages are available:

Dansk (Danish), Deutsch (German), English (English), Espanol (Spanish), Francais (French), Italiano 

(Italian), Nederlands (Dutch), Norsk (Norwegian), (Portugues), Svenska (Swedish)

The default interface language is English.
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3 Click [User Guide].

4 Read the license agreement, click [I accept the terms of the license agreement], and then click [Next > ].

5 Confirm the location in which you want to install User Guide, and then click [Next >].

To change the installation location, click [Change...].
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6 Confirm the program folder in which you want to install User Guide, and then click [Next >].

7 Click [Install].

Installation starts.

During installation, a message asking whether you want to create a desktop shortcut icon is dis-

played. Click [Yes] or [No] as appropriate.

8 When installation is complete, click [Finish].

To use the printer, the printer driver must be installed. See “Installing the Printer Driver (USB)”, 

User Guide.
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How to Use User Guide

User Guide (on the provided CD-ROM) includes detailed information about this printer and a trou-

bleshooting guide.

Use one of the browsers below to display User Guide.

Microsoft Internet Explorer Version 4.01 SP2 or later

Netscape 6.2 or later

To view the video files of User Guide, Macromedia Flash Player 5 plug in is required.

When using screen reader software or when you cannot install Macromedia Flash Player plugins

When using screen reader software to listen to User Guide or when video files cannot be dis-

played because Flash plug ins cannot be installed, click [For screen reader] to display User 

Guide version optimized for screen reader software.

Use the button in the upper right window to change the screen.

When using a non recommended browser

When using Internet Explorer 3.02 or Netscape Navigator 4.05 or later versions, a simplified 

User Guide is displayed.

If the simplified User Guide does not automatically appear, in the "Driver, Manual & Utility" 

CD ROM's [unv] folder, open index.htm.
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Opening User Guide

This section explains how to open User Guide.

Opening from the Icon

This section explains how to open User Guide from the desktop icon.

1 Double click the [User Guide] icon on your desktop.

The browser opens, and then User Guide appears.

Opening from the [Start] Menu

This section explains how to open User Guide from the Windows Start menu.

1 On the [Start] menu, point to [Programs] (Windows XP: [All Programs]), point to [Product Name], 

and then click [Product Name User Guide].

The browser opens, and then User Guide appears.

Depending on the settings made during installation, menu folder names may differ.
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Opening from the Printer Driver

This section explains how to open User Guide from the printer driver.

1 In the printer properties dialog box, click [User Guide] on the [Setup] tab.

The browser opens, and then User Guide appears.

Opening from the CD-ROM

This section explains how to open User Guide from the supplied CD-ROM.

1 Start Windows, and insert the provided "Driver, Manual & Utility" CD ROM into the CD ROM drive.

After inserting the CD ROM, the [Driver, Manual & Utility] dialog box appears. If it does not, dou-

ble click the CD ROM drive icon under [My Computer] or [Explorer], and then double click [SET-

UP.EXE].

2 Select a language for the interface, and then click [OK].

The following languages are available:

Dansk (Danish), Deutsch (German), English (English), Espanol (Spanish), Francais (French), Italiano 

(Italian), Nederlands (Dutch), Norsk (Norwegian), Portugues (Portuguese), Svenska (Swedish)

The default interface language is English.
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3 Click [Browse User Guide].

The browser opens, and then User Guide appears.

Opening from Printer Status Error Messages

This section explains how to open User Guide when Printer Status error message is dispayed.

1 The Status monitor displays an error message if a problem occurs.

2 Click [User Guide].

The browser opens, and then User Guide appears.

Open User Guide from here if a problem occurs while using the printer.
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2. Troubleshooting

This section explains how to troubleshoot machine setup problems.

Software Cannot Be Installed

This section explains how to troubleshoot software installation problems under different environ-

ments.

Confirming Installation

Check whether the software has been installed.

Checking icons When the printer driver is properly installed, the icon 

of the printer appears in the [Printers] folder.

When installation of User Guide is complete, User 

Guide icon appears on your desktop.

If the icons do not appear, the software is not prop-

erly installed. In this case, you must repeat the instal-

lation procedure. See "Quick Install for USB", Quick 

Installation Guide.

Checking the software You can install SmartDeviceMonitor for Client by 

clicking "Quick Install for Network" or "DeskTop-

Binder - SmartDeviceMonitor for Client". If SmartDe-

viceMonitor for Client is installed, the 

SmartDeviceMonitor for Client icon appears in the 

[SmartDeviceMonitor for Client] folder. To open the 

[SmartDeviceMonitor for Client] folder, select [Pro-

grams] on the [Start] menu, then select [DeskTop-

Binder], and then select [SmartDeviceMonitor for 

Client].

Checking ports In the printer properties dialog box, check that USB 

connection or network printer is selected as a port. 

To check the connection, perform a test print. If the 

test print is not printed, see p.25 "If Test Print Fails".
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Checking Your Computer Environment

Check the system requirements for installing the software.

Quick Install for USB

The CD ROM may not be inserted properly. Check that the "Driver, Manual & Utility"

CD ROM is inserted properly. Check also that it is 

not damaged and the CD ROM drive is working 

properly.

The power cord or USB cable may not be properly 

connected.

Check that the power cord and USB cable are prop-

erly connected and not damaged.

The operating system is incompatible.

There is insufficient hard disk space.

Check that the computer's operating system is fully 

compatible with this printer. See "Checking the Com-

puter and Installation Area", Quick Installation Guide.

Other applications are not closed. When installing software, quit all other applications. 

Installation may be disrupted if other applications 

are open. Also, quit any anti virus applications that 

are running.

Windows made USB settings automatically. Open Windows' Device Manager, and then, under 

[Universal Serial Bus controllers], remove any con-

flicting devices. Conflicting devices have a yellow [!] 

or [?] icon by them. Take care not to accidentally 

remove required devices. For details, see p.28 

"Deleting Devices".

The printer is turned on before installation. Switch the printer off and then on, and then try Quick 

Install for USB again.

Windows NT 4.0 is running. Windows NT 4.0 do not support USB connection 

with the printer. Connect the printer via a network 

in this case.

 [Quick Install for USB] is unavailable. See 

“Installing the Printer Driver (USB)”, User Guide.

Configure the printer as a shared network printer. 

See “Installing the Printer Driver”, User Guide.

For details about network printer settings, see 

“Sharing the Printer”, User Guide.

The USB connection does not work. Switch the printer off, unplug the USB cable from the 

printer, launch "Quick Install for USB" again, and 

then switch the printer on when the dialog box con-

firming printer driver installation appears. If this does 

not solve the problem, press the [Menu] key on the 

control panel, change "USB Setting" in [Host Inter-

face] from [Auto] to [Full Speed], uninstall the printer 

driver, delete the device, and then launch "Quick 

Install for USB" again.
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Quick Install for Network

An error occurs during software installation. If an error occurs because the printer is detected as 

an unidentified device, follow the instructions under 

"The USB connection does not work.". If this does not 

solve the problem, do the following: First reboot Win-

dows. Then, on the [Start] menu, select [Settings], 

and then select [Control Panel]. Double click the Sys-

tem icon, and then on the [Hardware] tab, click 

[Device Manager]. Under [Other Devices], select the 

printer, and then open its properties dialog box. On 

the [General] tab, click [Reinstall Driver] to reinstall 

the printer driver.

The CD ROM may not be inserted properly. Check that the "Driver, Manual & Utility"

CD ROM is inserted properly. Check also that it is 

not damaged and the CD ROM drive is working 

properly.

The power cord or Ethernet cable may not be prop-

erly connected.

Check that the power cord and Ethernet cable are 

properly connected and not damaged.

The operating system is incompatible.

There is insufficient hard disk space.

Check that the computer's operating system is fully 

compatible with this printer. See "Checking the Com-

puter and Installation Area", Quick Installation 

Guide.

Other applications are not closed. When installing software, quit all other applications. 

Installation may be disrupted if other applications 

are open. Also, quit any anti virus applications that 

are running.

The printer's IP address has not been specified.

The computer and printer are not on the same net-

work segment.

If the printer cannot be found and only "Printer Port" 

appears in the printer selection dialog box, either the 

printer's IP address has not been specified or the 

computer and printer are not on the same network 

segment. Before installing the software, check the 

printer's IP address and the network topology. Other-

wise, select "Printer Port" in the dialog box, and then 

install the printer driver. If you do this, SmartDevice-

Monitor for Client will not be simultaneously 

installed, so install it afterwards, and then configure 

the port.
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Printer Driver Cannot Be Installed

This section explains how to troubleshoot printer driver installation problems.

USB Connection is not Automatically Detected

If the USB connection is not automatically detected, do the following:

1 Delete the printer driver.

2 Delete the device.

3 Run [Quick Install for USB] again.

For details about deleting the printer driver, see p.26 "Uninstalling the Printer Driver".

For details about deleting the device, see p.28 "Deleting Devices".

For details about [Quick Install for USB], see “Quick Install for USB”, Quick Installation Guide.

If these steps do not solve the problem, contact your sales or service representative.

The printer driver installer does not start.

An error occurs during installation.

If the [Driver, Manual & Utility] screen does not 

appear even when you double click the 

[SETUP.EXE] icon, or if an error occurs during 

installation, access the CD ROM drive from [My 

Computer] or [Explorer]. Double click the [RDIS-

ETUP.EXE] icon, and then install the printer driver 

by following the instructions that appear on the 

screen.

An error occurs if the path to the location of the 

stored data is too long. To install a printer driver 

downloaded from a Website or copied from a 

CD ROM, save the printer driver directly on the 

hard disk, and then install it.

On the [Start] menu, point to [Settings], and then 

click [Printers]. In the [Printers] window, install the 

printer driver.

For details, see Windows Help.
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If Test Print Fails

This section explains how to troubleshoot Test Print problems.

If you cannot solve the problem, contact sales or service representative.

If the Status monitor displays an error message, see "Status Monitor Errors", User Guide.

The power cord or USB cable or Ethernet cable is 

not properly connected.

Check that the power cord and USB cable, Ehernet 

cable are properly connected.

The port connection is not properly set. 1) On the [Start] menu, point to [Settings], and then 

click [Printers].

2) Click the icon of the printer, and then click [Proper-

ties] on the [File] menu.

3) Click the [Details] tab (Windows 2000/XP, Win-

dows Server 2003, Windows NT 4.0: the [Ports] 

tab) , and then check the printer port.

Select USB or network printer in the list 

when the selected port connection is some-

thing other than USB or network printer.

To connect via USB when USB does not 

appear in the list, you must re install the 

printer driver. See p.24 "USB Connection is 

not Automatically Detected".

Ink feed is incomplete. Ink begins automatically feeding into the print heads 

when the power of the printer is first turned on or 

when a cartridge is replaced.

Wait until ink feed is complete at which point the 

[Power] key stops blinking and remains lit.

The printer is offline. Check if the printer’s on line indicator is lit. If the 

printer is offline, press the [Online] key on the control 

panel to switch the printer to the on line mode.

A printer error has occurred. Use the control panel to check if a printer error has 

occurred. If it has, try printing again.
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Uninstalling

If software was installed incorrectly or incompletely, uninstall and then reinstall it.

Before uninstalling software or deleting devices, turn off any other printers connected to your 

computer via USB, or disconnect the USB cable to the printers.

The following explanation uses Windows 98 as an example. Procedures under other operating 

systems may differ.

Screens vary according to the operating environment.

To reinstall the software, restart Windows.

When reinstalling the software, see Quick Installation Guide.

Uninstalling the Printer Driver

To update the printer driver, uninstall the old printer driver before installing the new one.

The following explanation uses Windows 98 as an example. Procedures under other operat-

ing systems may differ.

The Status monitor installed with the current printer driver is uninstalled when the current printer 

driver is uninstalled.

Registered custom settings are also deleted. To continue using registered custom settings, save them 

as custom settings files before uninstalling.

1 Press the printer's [Power] key to turn the printer off.

2 On the [Start] menu, point to [Settings], and then click [Printers].

AKS008S
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3 Click the icon of the printer, and then click [Delete] on the [File] menu.

A confirmation message appears.

4 Click [Yes].

The printer driver is uninstalled.

5 Double click [My computer].

6 On the [View] menu, click [Folder Options...].

7 Click the [View] tab.

8 In the [Advanced Settings:] box, click [Do not show hidden files], and then deselect the [Display the 

full path in title bar] check box.

9 Click [OK].

10 On the [Start] menu, point to [Find], and then click [Files or Folders...].

11 Click the [Name & Location] tab, and then enter "RCD6D19X.inf" in the [Named:] field.

12 In the [Look in:] box, select the hard disk on which Windows is installed, and then click [Find Now].

13 Right click the file displayed as the search result, and then click [Delete...].

The INF file is uninstalled.
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14 After uninstalling the printer driver, restart Windows.

For details about storing registered custom settings, see “Saving a Registered Custom Setting in a 

File”, User Guide.

For details about updating the printer driver, contact your sales or service representative.

Deleting Devices

If Windows automatically establishes a USB connection because of an unauthorized device, you 

can delete the device and any others like it. Be sure not to delete necessary devices. If USB connec-

tion is established normally, you do not need to perform this procedure.

The following explanation uses Windows 98 as an example. Procedures under other operat-

ing systems may differ.

1 Press the printer's [Power] key to turn the printer on.

2 On the [Start] menu, point to [Settings], and then click [Control Panel].

3 Double click [System].

4 Click the [Device Manager] tab.

AKS008S
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5 Click [GJ USB Printing Support] or [Product Name].

6 Click [Remove].

A confirmation message appears.

7 Click [OK].

8 Click [Close].

Uninstalling User Guide

If User Guide is installed incorrectly or incompletely, uninstall and then reinstall it.

1 Press the printer's [Power] key to turn the printer off.

2 Open [My Computer], and then open [Control Panel].

AKS008S
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3 Double click [Add/Remove Programs].

4 Select the installed [Product Name User Guide], and then click [Add/Remove...].

5 Follow the instructions that appear.
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Declaration of Conformity

“The Product complies with the requirements of the EMC Directive 89/336/EEC and its amending directives and 

the Low Voltage Directive 73/23/EEC and its amending directives.”

In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

 means STAND BY.

Noise Emission*1

Sound Power Level

Sound Pressure level*2

*1 The preceding measurements made in accordance with ISO7779 are actual values.
*2 Measured at the position of a bystander.

Main unit only

During Printing 58.1 dB(A)

Standby 26.8 dB(A)

Main unit only

Standby 16.5 dB(A)

During Printing 50.7 dB(A)

Copyright © 2005-2007
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CE Marking Traceability Information (For EU Countries Only.)

Manufacturer:
Ricoh Co., Ltd.
3-6 Nakamagome 1-chome, Ohta-ku, 
Tokyo, 143-8555 Japan

Authorized representative:
Ricoh Europe PLC
66 Chiltern Street London W1U 4AG U.K.

Model number: GX 3000

Printed in the Netherlands
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